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CAN BUS ANALYZER
USER’S GUIDE
Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
Chapter Name. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Warranty Registration

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT 

This document describes how to use the Chapter Name as a development tool to 
emulate and debug firmware on a target board. The manual layout is as follows:

• Chapter 1. “Introduction”

• Chapter 2. “Installation” 

• Chapter 3. “Using the PC GUI”

• Appendix A. “Error Messages”

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available on-line help files.
 2011 Microchip Technology Inc. DS51848B-page 5



CAN Bus Analyzer User’s Guide
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS51848B-page 6  2011 Microchip Technology Inc.



Preface
WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending in the Warranty Registration Card entitles users to receive new product 
updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user's guide describes how to use the CAN Bus Analyzer on a CAN network. The 
following Microchip documents are available on www.microchip.com and are recom-
mended as supplemental reference resources to understand CAN (Controller Area 
Network) more thoroughly.

AN713, Controller Area Network (CAN) Basics

This application note describes the basics and key features of the CAN protocol. 

AN228, A CAN Physical Layer Discussion

AN754, Understanding Microchip’s CAN Module Bit Timing

These application notes discuss the MCP2551 CAN transceiver and how it fits within 
the ISO-11898 specification. ISO-11898 specifies the physical layer to ensure compat-
ibility between CAN transceivers.

CAN Design Center

Visit the CAN design center on Microchip’s web site (www.microchip.com/CAN) for 
information on the latest product information and new application notes.
 2011 Microchip Technology Inc. DS51848B-page 7
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers and other language 
tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ 
and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; 
and MPLIB™ and MPLAB LIB30 object librarians.

• Emulators – The latest information on Microchip in-circuit emulators. This 
includes the MPLAB ICE 2000 and MPLAB ICE 4000.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debugger, MPLAB ICD 2.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 
and general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
the MPLAB PM3 and PRO MATE II device programmers and the PICSTART® 
Plus and PICkit™ 2 and 3 development programmers.
DS51848B-page 8  2011 Microchip Technology Inc.



Preface
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (July 2009)

• Initial Release of this Document.

Revision B (October 2011)

• Updated sections 1.1, 1.3, 1.4 and 2.3.2. Updated the figures in Chapter 3, and 
updated sections 3.2, 3.8 and 3.9.
 2011 Microchip Technology Inc. DS51848B-page 9
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CAN BUS ANALYZER
USER’S GUIDE
Chapter 1.  Introduction
1.1 INTRODUCTION

The CAN BUS Analyzer Tool is intended to be a simple-to-use, low-cost CAN Bus 
monitor which can be used to develop and debug a high-speed CAN network. The tool 
features a broad range of functions which allow it to be used across various market 
segments including automotive, marine, industrial and medical.

The CAN Analyzer tool supports CAN 2.0b and ISO 11898-2 (high-speed CAN with 
transmission rates of up to 1 Mbit/s). The tool can be connected to the CAN network 
using the DB9 connector or through a screw terminal interface.

The CAN BUS Analyzer has the standard functionality expected in an industry tool 
such as trace, transmit, trace filter, log file capability, and group CAN message transmit. 
All of these features make it a very versatile tool, allowing fast and simple debugging 
in any high-speed CAN network.

The chapter contains the following information:

• CAN BUS Analyzer Kit Contents

• Overview of CAN BUS Analyzer

• CAN BUS Analyzer Hardware Features

• CAN BUS Analyzer Software 

1.2 CAN BUS ANALYZER KIT CONTENTS

1. CAN BUS Analyzer Hardware

2. CAN BUS Analyzer Software

• The CAN BUS Analyzer software CD includes three components:

- Firmware for the PIC18F2550 (Hex File)

- Firmware for the PIC18F2680 (Hex File)

- The CAN BUS Analyzer PC GUI

3. USB mini cable to connect the CAN BUS Analyzer to the PC

1.3 OVERVIEW OF THE CAN BUS ANALYZER

The CAN BUS Analyzer provides similar features available in a high-end CAN network 
analyzer tool at a fraction of the cost. The CAN BUS Analyzer tool can be used to mon-
itor and debug a CAN network with an easy-to-use graphical user interface. The tool 
allows the user to view and log received and transmitted messages from the CAN BUS. 
The user is also able to transmit single or periodic CAN messages onto a CAN BUS, 
which is useful during development or testing of a CAN network.

Using this CAN BUS Analyzer tool has many advantages over the traditional debug-
ging methods embedded engineers typically rely on. For example, the tool trace win-
dow will show the user the received and transmitting CAN messages in an easy to read 
format (ID, DLC, data bytes and timestamp).
 2011 Microchip Technology Inc. DS51848B-page 11



CAN Bus Analyzer User’s Guide
1.4 CAN BUS ANALYZER HARDWARE FEATURES 

The CAN BUS Analyzer hardware is a compact tool that includes the following hard-
ware features. Refer to Section 1.5 “CAN BUS Analyzer Software” for more informa-
tion about the software features.

FIGURE 1-1: CAN BUS ANALYZER

• Mini USB Connector

This connector provides the CAN BUS Analyzer a communication medium to the 
PC, but it can also provide a power supply if the external power supply is not 
plugged into the CAN BUS Analyzer.

• 9-24 Volt power supply connector

When powered by the external power supply, the tool can be set up to disconnect 
from the PC to act as a periodic transmitter for CAN BUS messages. The tool 
can also be set up to send out a pulse upon reception of certain CAN messages, 
which is useful during development or debugging issues with an oscilloscope.

• DB9 connector for the CAN BUS

• Termination Resistor (software controllable)

The user can turn ON or OFF the 120 ohm CAN bus termination through the PC 
GUI.

• Status LEDs

Displays the USB status.

• Trigger LED

Future functionality.

• CAN Traffic LEDs

Shows the actual RX CAN BUS traffic from the high speed transceiver.

Shows the actual TX CAB BUS traffic from the high speed transceiver.

• CAN BUS Error LED

Shows the Error Active (Green), Error Passive (Yellow), Bus Off (Red) state of 
the CAN BUS Analyzer.

• Direct access to the CAN H and CAN L pin through a screw terminal

Allows the user access to the CAN bus for connecting an oscilloscope without 
having to modify the CAN BUS wire harness.

• Direct access to the CAN TX and CAN RX pins through a screw terminal

Allows the user access to the digital side of the CAN BUS transceiver.
DS51848B-page 12  2011 Microchip Technology Inc.
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FIGURE 1-2: CAN BUS ANALYZER SCHEMATIC
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1.5 CAN BUS ANALYZER SOFTWARE

The CAN BUS Analyzer comes with two firmware hex files and PC software which 
provides the user with a graphical interface to configure the tool and analyze a CAN 
network. It has the following software tool features:

1. Trace: Monitor the CAN bus traffic.

2. Transmit: Transmit single shot, periodic, or periodic messages with a limited 
repeat onto the CAN bus.

3. Group Transmit: Transmit a list of CAN messages, in order, onto the CAN bus.

4. Trace Filter Setup: Configure which CAN messages from the CAN bus traffic are 
visible on the Trace Window.

5. Log File Setup: Save CAN bus traffic.

6. Hardware Setup: Configure the CAN BUS Analyzer for the CAN network.

Note: Some features will be implemented in future releases.
DS51848B-page 14  2011 Microchip Technology Inc.



CAN BUS ANALYZER
USER’S GUIDE
Chapter 2.  Installation
2.1 INTRODUCTION

The following chapter describes the procedures for installing the CAN Analyzer 
hardware and software.

The chapter contains the following information:

• Installing CAN BUS Analyzer Software

• Installing CAN BUS Analyzer Hardware

2.2 SOFTWARE INSTALLATION 

2.2.1 Installing the GUI

Install .NET framework version 3.5 before installing the CAN BUS Analyzer.

1. Run “CANAnalyzer_verXYZ.exe”, where “XYZ” is the version number of the 
software. By default this will install the files to: C:\Program Files\Microchip 
Technology Inc\CANAnalyzer_verXYZ

2. Run the setup.exe from folder: C:\Program Files\Microchip Technology 
Inc\CANAnalyzer_verXYZ\GUI

3. The setup will create a shortcut in the Programs Menu under “Microchip 
Technology Inc” as Microchip CAN Tool ver XYZ. 

4. If the CAN BUS Analyzer PC software is being upgraded to a newer version, the 
firmware should be updated to match the revision level of the PC software.  
When updating the firmware, ensure that the hex files are programmed into their 
respective PIC18F microcontrollers on the CAN BUS Analyzer hardware.

2.2.2 Upgrading the Firmware

If upgrading the firmware in the CAN BUS Analyzer, the user will need to import the 
HEX files into MBLAB® IDE and program the PIC® MCUs. When programming the 
PIC18F2680, the user may power the CAN BUS Analyzer by external power supply or 
by the mini USB cable. When programming the PIC18F550, the user needs to power 
the CAN BUS Analyzer by external power supply. Additionally, when programming 
HEX files into PIC MCUs, it is recommended to check the firmware version from the 
GUI. This can be done by clicking on the “Help > About” menu option.
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2.3 HARDWARE INSTALLATION

2.3.1 System Requirements

• Windows® XP

• .NET framework version 3.5

• USB Serial Port

2.3.2 Power Requirements

• A power supply (9 to 24 Volt) is needed when operating without the PC and when 
updating firmware in the USB PIC MCU

• The CAN BUS Analyzer tool can also be powered using the USB port

2.3.3 Cable Requirements

• Mini USB cable – for communicating with the PC Software

• The CAN Analyzer tool can be connected to a CAN network using the following:

- Via the DB9 connector

- Via screw-in terminals

2.3.4 Connecting the CAN BUS Analyzer to the PC and CAN BUS

1. Connect the CAN Analyzer via the USB connector to the PC. You will be 
prompted to install the USB drivers for the tool. The drivers can be found in this 
location: 
C:\Program Files\Microchip Technology Inc\CANAnalyzer_verXYZ

2. Connect the tool to the CAN network using the DB9 connector or the screw in 
terminals. Please refer to Figure 2-1 and Figure 2-2 for the DB9 connector and 
the screw terminals for connecting the network to the tool.

FIGURE 2-1: PINOUT FOR THE DB9 CONNECTOR

TABLE 2-1: 9-PIN (MALE) D-SUB CAN BUS PINOUT

Pin Number Signal Name Signal Description

1 No Connect N/A

2 CAN_L Dominant Low

3 GND Ground

4 No Connect N/A

5 No Connect N/A

6 GND Ground

7 CAN_H Dominant High

8 No Connect N/A

9 No Connect N/A
DS51848B-page 16  2011 Microchip Technology Inc.
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FIGURE 2-2: PINOUT FOR THE SCREW-IN TERMINALS

TABLE 2-2: 6-PIN SCREW CONNECTOR PINOUT

Pin Number Signal Names Signal Description

1 Vcc PIC® MCU Power Supply

2 CAN_L Dominant Low

3 CAN_H Dominant High

4 RXD CAN Digital Signal from 
Transceiver

5 TXD CAN Digital Signal from 
PIC18F2680

6 GND Ground
 2011 Microchip Technology Inc. DS51848B-page 17
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NOTES:
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Chapter 3.  Using the PC GUI
Once the hardware is connected and the software is installed, open the PC GUI using 
the shortcut in the Programs Menu under “Microchip Technology Inc” labeled as 
Microchip CAN Tool ver XYZ. Figure 3-1 is a screen shot of the default view for the CAN 
BUS Analyzer.

FIGURE 3-1: CAN BUS ANALYZER DEFAULT VIEW

3.1 GETTING STARTED WITH A QUICK SETUP

The following are setup steps to quickly start transmitting and receiving on the CAN 
BUS.  For more details, refer to the individual sections for the different PC GUI features.

1. Connect the CAN BUS Analyzer to the PC with the mini USB cable

2. Open the CAN BUS Analyzer PC GUI

3. Open the Hardware Setup and select the CAN BUS bitrate on the CAN BUS

4. Connect the CAN BUS Analyzer to the CAN BUS

5. Open the Trace window

6. Open the Transmit Window
 2011 Microchip Technology Inc. DS51848B-page 19
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3.2 TRACE FEATURE

There are two types of Trace windows: Fixed and Rolling.  To activate either Trace 
window, select the option from the main Tools menu.

FIGURE 3-2: FIXED TRACE WINDOW

FIGURE 3-3: ROLLING TRACE WINDOW

The Trace window displays the CAN BUS traffic in a readable form. This window will 
list the ID (Extended is signified with an preceding 'x' or Standard), DLC, DATA Bytes, 
the Time stamp and the time difference from the last CAN BUS message on the BUS. 
The Rolling Trace window will show the CAN messages sequentially as they appear on 
the CAN BUS. The time delta between messages will be based on the last received 
message regardless of CAN ID.

The Fixed Trace window will show the CAN messages in a fixed position on the trace 
window. The message will still be updated, but the time delta between messages will 
be based on the previous message with the same CAN ID. 

The Trace window can also be configured with filters to show only certain IDs. This can 
be configured in the Trace Filter Setup (refer to Section 3.5 “Future Feature –Trace 
Filter Setup Feature”).
DS51848B-page 20  2011 Microchip Technology Inc.



Using the PC GUI
3.3 TRANSMIT FEATURE

To activate the Transmit window, select “TRANSMIT” from the main Tools menu.

FIGURE 3-4: TRANSMIT WINDOW

The Transmit window allows the user to interact with other nodes on the CAN BUS by 
transmitting messages. The user is able to enter any ID (Extended or Standard), DLC 
or DATA Bytes combination for single message transmittal. The transmit window also 
allows the user to transmit a maximum of nine separate and unique messages either 
periodically or periodically with a limited “repeat” mode. When using the limited repeat 
mode, the message will be sent out at the periodic rate for a number of “repeat” times.

3.3.1 Steps to Transmit a Single-Shot Message

1. Populate the CAN message fields, which include the ID, DLC and DATA

2. Populate the Periodic and Repeat fields with “0”

3. Click on the Send button for that row

3.3.2 Steps to Transmit a Periodic Message

1. Populate the CAN message fields, which include the ID, DLC and DATA

2. Populate the Periodic field (50 ms to 5000 ms)

3. Populate the Repeat field with “0” (which translates to “repeat forever”)

4. Click on the Send button for that row

3.3.3 Steps to Transmit a Periodic Message with Limited Repeats

1. Populate the CAN message fields, which include the ID, DLC and DATA

2. Populate the Periodic field (50 ms to 5000 ms)

3. Populate the Repeat field (with a value from 1 to 10)

4. Click on the Send button for that row
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3.4 FUTURE FEATURE – GROUP TRANSMIT FEATURE

To activate the Group Transmit window, select “GROUP TRANSMIT” from the main 
Tools menu.

FIGURE 3-5: GROUP TRANSMIT WINDOW

The Group Transmit window allows the user to interact with other nodes on the CAN 
BUS by transmitting messages.  The user is able to transmit a limited group of mes-
sages in sequential order spaced out by user-defined timing in the Period field.  All 
messages can be unique to each other in terms of ID, DLC, Data bytes and time 
between messages.

3.4.1 Steps to Transmit a Group of CAN Messages

1. Fill in the CAN message fields which include the ID, DLC and DATA for all 
messages that will be transmitted

2. Ensure that the Periodic field is populated for each message (50 ms to 5000 ms). 
This field represents the time between messages

3. Click on the Send button for that row.  The row will be highlighted for the current 
transmitted message
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3.5 FUTURE FEATURE –TRACE FILTER SETUP FEATURE

To activate the Trace Filter Setup window, select “TRACE FILTER SETUP” from the 
main Tools menu.

FIGURE 3-6: TRACE FILTER SETUP WINDOW

The Trace Filter Setup window allows the user to filter the Trace window for only the 
required IDs the user wants to view.  The trace filter can match the log file filter or it can 
contain a completely different set of IDs.

Steps to setup the trace filter to match the log file filter

1. Make sure the Log File Filter is “Turned On”

2. Click on the “IDs Match Log File Filter” checkbox.  The Trace ID Filter Setup 
options will become disabled

3. Click on the “Enable Trace Filter” checkbox to enable the filter

4. Confirm on the Trace window that the status of the trace filter changes from 
“Trace Filter Inactive” to “Trace Filter Active” (highlighted green)

Steps to setup the trace filter to be independent of the log file filter

1. Determine if the filter will work as an include or an exclude filter

2. Enter CAN IDs into the CAN ID text field and click on the “Add ID” button.  Repeat 
this process until all CAN IDs for the filter are entered

3. Click on the “Enable Trace Filter” checkbox to enable the filter

4. Confirm on the Trace window that the status of the trace filter changes from 
“Trace Filter Inactive” to “Trace Filter Active (highlighted green)
 2011 Microchip Technology Inc. DS51848B-page 23



CAN Bus Analyzer User’s Guide
3.6 LOG FILE SETUP FEATURE

To activate the Log File Setup window select “LOG FILE SETUP” from the main Tools 
menu.

FIGURE 3-7: LOG FILE SETUP WINDOW

The Log File Setup window allows the user to setup a log file of the CAN BUS traffic.  
This feature helps gather more information when debugging design issues, by captur-
ing the BUS traffic when an event occurs.

Log File Setup also allows the user to setup a filter to either include or exclude 
user-defined IDs.

Steps to setup a log file

1. Browse to a folder to which you want to save your log file

2. Click on the “Enable Logging” checkbox to enable writing

Steps to setup a log file with a filter

1. Determine if the log file filter should work as an include or an exclude filter

2. Enter CAN IDs into the CAN ID text field and click on the “Add ID” button.  Repeat 
this process until all of the CAN IDs for the filter are entered

3. Browse to a folder to which you want to save your log file

4. Click on the “Enable Logging” checkbox to enable writing

5. Confirm on the Trace window that the status of the trace filter changes from 
“Logging Inactive” to “Logging Active” (highlighted green)
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3.7 HARDWARE SETUP FEATURE

To activate the Hardware Setup window, select “HARDWARE SETUP” from the main 
Tools menu.

FIGURE 3-8: HARDWARE SETUP WINDOW

The HARDWARE SETUP window allows the user to setup the CAN BUS Analyzer for 
communication on the CAN BUS. This feature also gives the user the ability to quickly 
test the hardware on the CAN BUS Analyzer.

To set up the tool to communicate on the CAN BUS:

1. Select the CAN bitrate from the drop-down combo box.

2. Click the “Set” button. Confirm bitrate has changed by viewing the bitrate setting 
on the bottom of the main CAN BUS Analyzer window.

3. If the CAN BUS needs the termination resistor active, then turn it ON by clicking 
the “Turn On” button for the Bus Termination.

Test the CAN BUS analyzer hardware:

1. Ensure that the CAN BUS analyzer is connected. You can confirm this by viewing 
the tool connection status on the status strip on the bottom of the main CAN BUS 
Analyzer window.

2. To confirm that the communication is working between the USB PIC MCU and 
the CAN PIC MCU, click on the  “Help->About” main menu option to view the ver-
sion numbers of the firmware loaded into each PIC MCU.
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3.8 FUTURE FEATURE – SAVING AND RETRIEVING THE TOOL 
CONFIGURATIONS

3.8.1 Saving Tool Configurations

The CAN BUS Analyzer tool allows the user to save various configuration setups by 
the user in a particular session. The GUI will save the transmit window settings, log file 
settings, and screen positions of the various windows of the tool. 

By choosing “Save Configuration” under the File menu, the file is saved in a default 
Temp folder under the default name “config.ini”. 

By choosing “Save As” under the file menu, the user can define the path and name for 
the configuration file. 

3.8.2 Retrieving Tool Configurations

Under the File menu, select “Open Configuration” and then select the desired “.ini” file 
to retrieve the configuration saved by the user. 
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Appendix A. Error Messages
In this section, the various “pop-up” errors that are found in the GUI will be discussed 
in detail as to why they may occur, and the possible solutions for correcting the errors.

TABLE A-1: ERROR MESSAGES

Error 
Number

Error Possible Solution

1.00.x Trouble reading the USB firmware 
version

Unplug/plug the tool into the PC. Also make sure that 
the PIC18F2550 is programmed with the proper HEX 
file.

2.00.x Trouble reading the CAN firmware 
version

Unplug/plug the tool into the PC. Also make sure that 
the PIC18F2680 is programmed with the proper HEX 
file.

3.00.x ID field is empty The value in the ID field can not be empty for a mes-
sage that a user is requesting to be transmitted. Enter a 
valid value.

3.10.x DLC field is empty The value in the DLC field can not be empty for a mes-
sage that a user is requesting to be transmitted. Enter a 
valid value.

3.20.x DATA field is empty The value in the Data field can not be empty for a mes-
sage that a user is requesting to be transmitted. Enter a 
valid value. Remember, the DLC value drives how 
many data bytes will be sent.

3.30.x PERIOD field is empty The value in the Period field can not be empty for a 
message that a user is requesting to be transmitted. 
Enter a valid value.

3.40.x REPEAT field is empty The value in the Repeat field can not be empty for a 
message that a user is requesting to be transmitted. 
Enter a valid value.

4.00.x Enter the Extended ID within the 
following range (0x-1FFFFFFFx)

Enter a valid ID into the text field. The tool is expecting 
a hexidecimal value for an extended ID in the range of 
“0x-1FFFFFFFx”. When entering an extended ID, make 
sure to append ‘x’ onto the ID.

4.02.x Enter the Extended ID within the 
following range (0x-536870911x)

Enter a valid ID into the text field. The tool is expecting 
a decimal value for an extended ID in the range of 
“0x-536870911x”. When entering an extended ID, 
make sure to append ‘x’ onto the ID.

4.04.x Enter the Standard ID within the 
following range (0-7FF)

Enter a valid ID into the text field. The tool is expecting 
a hexidecimal value for a standard ID in the range of 
“0-7FF”. When entering an extended ID, make sure to 
append ‘x’ onto the ID.

4.06.x Enter the Standard ID within the 
following range (0-2047)

Enter a valid ID into the text field. The tool is expecting 
a decimal value for a standard ID in the range of 
“0-2048”. When entering an extended ID, make sure to 
append ‘x’ onto the ID.
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4.10.x Enter DLC within the following range 
(0-8)

Enter a valid DLC into the text field. The tool is 
expecting a value in the range of “0-8”.

4.20.x Enter DATA within the following range 
(0-FF)

Enter valid Data into the text field. The tool is expecting 
a hexidecimal value in the range of “0-FF”.

4.25.x Enter DATA within the following range 
(0-255)

Enter valid Data into the text field. The tool is expecting 
a decimal value in the range of “0-255”.

4.30.x Enter a valid PERIOD within the 
following range (100-5000)\nOr (0) for 
a one shot message

Enter a valid Period into the text field. The tool is 
expecting a decimal value in the range of “0 or 
100-5000”.

4.40.x Enter a valid REPEAT within the 
following range (1-99)\nOr (0) for a 
one shot message

Enter a valid Repeat into the text field. The tool is 
expecting a decimal value in the range of “0-99”.

4.70.x Unknown error caused by user input Check that the text field only has no special characters 
or spaces.

4.75.x Required input for CAN Message is 
empty

Check that the ID, DLC, DATA, PERIOD, and REPEAT 
fields contain valid data.

5.00.x Reserved for Message Received 
Errors

Reserved for Message Received errors.

6.00.x Unable to Log Data Tool is unable to write CAN traffic to Log File. Possible 
cause may be that the drive is either full, write 
protected, or does not exist.

Error 
Number

Error Possible Solution
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